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1 How Do I?
Learn how to use your HP All-in-One

• Printer parts on page 5
• Load media on page 18
• Replace the cartridges on page 30
• Clear a paper jam on page 38
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2 Get to know the HP All-in-One
• Printer parts
• Control panel features
• Wireless Settings
• Status Lights
• Auto Power-Off

Printer parts
• Front and top views of the HP All-in-One

1 Display

2 Control panel

3 Paper tray

4 Paper tray extender (also referred to as the tray extender)

5 Glass

6 Lid-backing

7 Lid

8 Cartridge door

9 Cartridge access area

10 Cleanout door

• Rear view of the HP All-in-One

11 Rear USB port

12 Power connection
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Control panel features
Control panel features

1 Back: Returns to the previous screen.

2 Cancel: Stops the current operation, restores default settings.

3 Setup: Opens the Setup menu where you can check ink levels, change Auto Power-Off setting, perform maintenance tasks,
and set language and region settings.

4 Selection buttons: Use buttons to select menu items on the printer display.

5 Wireless status light and button: Blue light indicates wireless connection. Pressing button opens wireless menu. Press and
hold until light blinks to start WPS push button mode.

6 ePrint light and button: White light indicates ePrint is connected. Pressing button displays printer's email address and ePrint
menu options.

7 On button

Wireless Settings
Press the Wireless button to view wireless status and menu options.

• If the printer has an active connection to a wireless network, the printer display will show Connected and the
printer’s IP.

• If wireless is disabled (wireless radio off) and the wireless network is not available, the display screen shows
Wireless Off.

• If wireless is enabled (wireless radio on) and you do not have a wireless connection , the display screen shows
that it is either in the process of Connecting or Not Connected.

You can use the printer display to retrieve information about your wireless network, establish a wireless connection,
and more.

How do I? Instructions

Print network configuration page.
The network configuration page will display the network status, hostname,
network name, and more.

1. Press the Wireless button to display the
Wireless Menu.

2. From the Wireless Menu, select Print
Reports.

3. From the Print Reports menu select
Configuration.
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How do I? Instructions

Print wireless network test report.
The wireless network test report will display the diagnostics results for the
status of the wireless network, wireless signal strength, detected networks,
and more.

1. Press the Wireless button to display the
Wireless Menu.

2. From the Wireless Menu, select Print
Reports.

3. From the Print Reports menu select Wireless
Test.

View signal strength of wireless connection. 1. Press the Wireless button to display the
Wireless Menu.

2. From the Wireless Menu, select Connected
IP XXX.XXX.XX.XX.

3. Printer display will show wireless signal
strength.

Restore network settings to default settings. 1. Press the Wireless button to display the
Wireless Menu.

2. From the Wireless Menu, select Settings.
3. From the Settings menu, select Restore

Defaults.
4. Confirm selection to restore defaults.

Turn wireless on or off. 1. Press the Wireless button to display the
Wireless Menu.

2. From the Wireless Menu, select Wireless
Settings.

3. From the Settings menu, select Wireless On/
Off.

4. From the Wireless On/Off menu select On or
Off.

Establish a Wi-Fi Protected Setup (WPS) connection. WiFi Protected Setup (WPS – requires WPS
router) on page 33

Status Lights
• Wireless Status Light
• ePrint Status Light
• On Button Light

Wireless Status Light

Light behavior Solution

Off Wireless is off. Press Wireless button to access
wireless menu on the printer display. Use wireless
menu to enable wireless printing.

Slow blinking Wireless is on but not connected to a network. If
connection cannot be established, make sure
printer is within range of wireless signal.

Fast blinking Wireless error has occurred. Refer to messages on
printer display.

On Wireless connection has been established and you
can print.

(continued)

Status Lights 7

G
et

 to
 k

no
w

 th
e 

H
P 

A
ll-

in
-O

ne



ePrint Status Light

Light behavior Solution

Off ePrint is disabled. Press ePrint button to access
ePrint menu on the printer display.

On ePrint is on and connected.

On Button Light
Light behavior Solution

Off The device is powered off.

Pulsing Indicates the device is in sleep mode. The device
automatically enters sleep mode after 5 minutes of
inactivity.

Fast blinking Error has occurred. Refer to messages on printer
display.

On Printer is on and ready to print.

Auto Power-Off
Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is enabled,
the printer automatically turns off after 2 hours of inactivity to help reduce energy use. Auto Power-Off is automatically
disabled when the printer establishes a wireless or Ethernet (if supported) network connection. You can change the
Auto Power-Off setting from the control panel. Once you change the setting, the printer maintains the setting. Auto
Power-Off turns the printer off completely, so you must use the power button to turn the printer back on.

To change Auto Power-Off setting
1. From the Control Panel home screen, which displays Copy, Scan, and Quick Forms, press the Setup button.

NOTE: If you do not see the home screen, press the Back button until you can see it.

2. From the Setup menu on the printer display, select Auto Power-Off.
3. From the Auto Power-Off menu select Enabled or Disabled, and then confirm the setting.

TIP: If you are printing over a wireless or Ethernet connected network, Auto Power-Off should be disabled to
ensure that print jobs do not get lost. Even when Auto Power-Off is disabled, the printer enters Sleep mode after
5 minutes of inactivity to help reduce energy use.
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3 Print
Choose a print job to continue.

Print photos on page 9

Print documents on page 10

Print envelopes on page 11

Print Quick Forms on page 10

See Tips for print success on page 11 for more information.

Print photos
To print a photo on photo paper
1. Pull out the paper tray.
2. Remove all paper from the paper tray, and then load the photo paper with side to be printed on facing down.

NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs face outward.

See Load media on page 18 for more information.
3. On the File menu in your software application, click Print.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

6. Select the appropriate options.
• On Layout tab select Portrait or Landscape orientation.
• On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.

Print 9
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NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select Photo Paper, Best Quality
from the Media drop-down list. Then go to the Advanced tab and select Yes from the Print in Max DPI
drop-down list. If you want to print Max DPI in grayscale, select High Quality Grayscale from Print in
Grayscale on the drop-down list, and then select Max DPI, after selecting Photo Paper, Best Quality.

7. Click OK to return to the Properties dialog box.
8. Click OK, and then click Print or OK in the Print dialog box.

NOTE: Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce
the quality of your printout. Photo paper should be flat before printing.

Print documents
To print from a software application
1. Make sure the paper tray is open.
2. Make sure you have paper loaded in the paper tray.

See Load media on page 18 for more information.
3. From your software application, click the Print button.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

6. Select the appropriate options.
• On Layout tab select Portrait or Landscape orientation.
• On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.

7. Click OK to close the Properties dialog box.
8. Click Print or OK to begin printing.

NOTE: 1 You can print your document on both sides of the paper, instead of just one side. Click on the
Advanced button on the Paper/Quality or Layout tab. From the Pages to Print drop-down menu select Print
Odd Pages Only. Click OK to print. After the odd numbered pages of the document have been printed, remove
the document from the output tray. Reload the paper in the input tray with the blank side facing up. Return to
the Pages to Print drop-down menu and then select Print Even Pages Only. Click OK to print.

NOTE: 2 If your printed documents are not aligned within the margins of the paper, make sure that you have
selected the correct language and region. On the printer display, select Setup, then select Language/Region.
Select your language, and then region from the options provided. The correct Language/Region settings ensure
that the printer will have the appropriate default paper size settings.

Print Quick Forms
Use Quick Forms to print Office Forms, Paper Types, and Games.
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Print Quick Forms
1. Select Quick Forms from the printer display menu.

TIP: If the Quick Forms option does not appear on the printer display menu, press the Back button until
the Quick Forms option appears.

2. Press the selction buttons to select Office Forms, Paper Type, or Games. Then select OK.
3. After you have selected the type of Selection that you want to print, select the number of copies, then press

OK.

Print envelopes
You can load one or more envelopes into the input tray of the HP All-in-One. Do not use shiny or embossed
envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your word
processing software. For best results, consider using a label for the return address on envelopes.

To print envelopes
1. Make sure the paper tray is open.
2. Slide the paper guides outward.
3. Place the envelopes in the center of the tray. The side to be printed on should face down. The flap should be

on the left side.
See Load media on page 18 for more information.

4. Push the envelopes into the printer until they stop.
5. Slide the paper guides firmly against the edges of the envelopes.

6. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

7. Select the appropriate options.
• On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.

8. Click OK, and then click Print or OK in the Print dialog box.

Tips for print success
To successfully print, the HP cartridges should be functioning properly with sufficient ink, the paper should be loaded
correctly, and the product should have the appropriate settings.

Ink tips
• Use genuine HP ink cartridges.
• Install the yellow, magenta, cyan, and black cartridges correctly.

For more information, see Replace the cartridges on page 30.
• Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

For more information, see Check the estimated ink levels on page 29.

Tips for print success 11
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• For more information, see Improve print quality on page 37.
• If you are seeing ink smears on the back of the pages that you printed, use the Tools menu to clean.

◦ From the home screen, which displays Copy, Scan, and Quick Forms, press the Setup button.

NOTE: If you do not see the home screen, press the Back button until you can see it.

◦ Scroll through the Tools menu until you see Clean Ink Smear, then select OK.
◦ Follow the onscreen instructions.

Paper loading tips
• Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to avoid

a paper jam.
• Load paper with side to be printed on facing down.
• Ensure that paper loaded in the paper tray lays flat and the edges are not bent or torn.
• Adjust the paper-width guides in the paper tray to fit snugly against all paper. Make sure the paper-width guide

does not bend the paper in the paper tray.
• For more information, see Load media on page 18.

Printer settings tips
• On the Paper/Quality tab of the print driver, select the appropriate paper type and print quality from the

Media drop-down list.
• Select the appropriate size from the Paper Size drop-down list on the Paper/Quality tab.
• Click the HP All-in-One desktop icon to open the Printer Software. In the Printer Software, click Printer

Actions and then click Set Preferences to access the print driver.

NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 3070
B611 series > HP Deskjet 3070 B611 series

Notes
• Genuine HP ink cartridges are designed and tested with HP printers and papers to help you easily produce great

results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required
as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

• Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge available
to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes
unacceptable.

• Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.
• You can print your document on both sides of the paper, instead of just one side.

NOTE: Click the Advanced button on the Paper/Quality or Layout tab. From the Pages to Print drop-
down list select Print Odd Pages Only. Click OK to print. After the odd numbered pages of the document
have been printed, remove the document from the output tray. Reload the paper in the input tray with the
blank side facing up. Return to the Pages to Print drop-down list and then select Print Even Pages Only.
Click OK to print.

• Print using black ink only

NOTE: If you want to print a black and white document using black ink only, click the Advanced button.
From the Print in Grayscale drop-down menu select Black Ink Only, then click the OK button.
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Print using the maximum dpi
Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

See technical specifications for the print resolution of the maximum dpi mode.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

To print in Maximum dpi mode
1. Make sure you have photo paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

5. Click the Paper/Quality tab.
6. In the Media drop-down list, click Photo Paper, Best Quality.

NOTE: Photo Paper, Best Quality must be selected from the Media drop-down list on the Paper/
Quality tab to enable printing in maximum DPI.

7. Click the Advanced button.
8. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
9. Select Paper Size from Paper/Output drop-down list.
10. Click OK to close the advanced options.
11. Confirm Orientation on Layout tab, then click OK to print.

Print using the maximum dpi 13
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4 ePrint from anywhere
The ePrint feature on your product provides convenience printing that allows you to print from anywhere. Once
enabled, ePrint assigns an email address to your product. To print, simply send an email containing your document
to that address. You can print images, Word, PowerPoint, and PDF documents. It's easy!

• ePrint from anywhere

ePrint from anywhere
To ePrint a document from anywhere
1. Find your ePrint email address.

a. Press the ePrint button on the control panel. You will see the web services Settings menu on the printer
display.

b. Select Display Email Address from the printer display to view the printer’s email address.

NOTE: To use ePrint, web services must first be enabled. If web services have not been enabled, you will
see a message directing you to the Printer Software. Open the Printer Software, select ePrint, then follow
the onscreen instruction to enable.

TIP: To print the email address or registration url, select Print Info Sheet from the Settings menu on the
printer display.

2. Compose and send email.
a. Create a new email and type the product email address in the To box.
b. Type text in the body of the email and attach the documents or images that you want to print.
c. Send the email.

The product prints your email.

NOTE: To receive email, your product must be connected to the Internet. Your email will print as soon
as it is received. As with any email, there is no guarantee when or if it will be received. When you register
online with ePrint, you can check the status of your jobs.

TIP: If you have enabled Auto Power-Off, you should disable it before using ePrint. For more information,
see Auto Power-Off on page 8

NOTE: 1 Device must be connected wirelessly and on an active network.

NOTE: 2 Documents printed with ePrint may appear different from the original. Style, formatting, and text flow
may differ from the original document. For documents that need to be printed with a higher quality (such as legal
documents), we recommend that you print from the software application on your computer, where you will have
more control over what your printout looks like.

 Click here to go online for more information.
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5 Paper basics
• Recommended papers for printing
• Load media

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of
project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok
• HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers

with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and
produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for
papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

HP Advanced Photo Paper
• This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears,

fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available
in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch),
and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
• Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable,

photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet
printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch)
(with or without tabs). For longer-lasting photos, it is acid-free.

HP Brochure Paper or HP Superior Inkjet Paper
• These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice

for near-photographic reproductions and business graphics for report covers, special presentations, brochures,
mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper
• These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters.

They are heavyweight for an impressive look and feel.

Paper basics 17

Pa
pe

r b
as

ic
s



HP Bright White Inkjet Paper
• HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided

color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok
Technology for less smearing, bolder blacks, and vivid colors.

HP Printing Paper
• HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial

than documents printed on standard multipurpose or copy paper. It features ColorLok Technology for less
smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

HP Office Paper
• HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday

documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for
longer lasting documents.

HP Iron-On Transfers
• HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-

shirts from your digital photos.

HP Premium Inkjet Transparency Film
• HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This film

is easy to use and handle and dries quickly without smudging.

HP Photo Value Pack
• HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save you

time and take the guesswork out of printing affordable professional photos with your HP All-in-One. Original HP
inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and
vivid, print after print. Great for printing out an entire vacation’s worth of photos or multiple prints to share.

Load media
▲ Select a paper size to continue.

Load full-size paper
a. Lower the paper tray.

� Lower the paper tray and pull out the tray extender.

b. Slide paper-width guides outward.
� Slide paper-width guides outward.
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c. Load paper.
� Insert stack of paper into paper tray with short edge forward and print side down.

� Slide stack of paper until it stops.
� Adjust paper-width guides so they fit against both sides of the stack of paper.

Load small-size paper
a. Slide the paper tray out.

� Slide the paper tray and pull out the tray extender.

b. Slide paper-width guides outward.
� Slide paper-width guides outward.

Load media 19
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c. Load paper.
� Insert stack of photo paper with short edge down and print side down.
� Slide stack of paper forward until it stops.

NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs face
outward.

� Adjust paper-width guides so they fit against both sides of the stack of paper.

� Slide paper tray in.

Load envelopes
a. Lower the paper tray

� Lower the output tray and pull out the tray extender.

b. Slide paper-width guides outward.
� Slide paper-width guide outward.
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� Remove all paper from the main input tray.
c. Load envelopes.

� Insert one or more envelopes in center of the input tray. The side to be printed on should face up. The
flap should be on the left side and facing down.

� Slide stack of envelopes down until it stops.
� Slide paper-width guide to the right against stack of envelopes until it stops.

Load media 21
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6 Copy and scan
• Copy
• Scan to a computer
• Tips for copy success
• Tips for scan success

Copy
▲ The copy menu on the printer display allows you to easily select number of copies and color or black and white

for copying on plain paper. For more advanced settings, such as changing the paper type and size, adjusting
the darkness of the copy, and resizing the copy, select Settings from the Copy Menu.
Click a copy type to continue.

Easy Copy
a. Load paper.

� Load full-size paper in the paper tray.

b. Load original.
� Lift lid on product.

� Load original print side down on right front corner of glass.

Copy and scan 23
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� Close lid.
c. Select Copy from the printer display menu to access the copy menu.

� If you do not see Copy on the printer display, press the back button until you see Copy.
� From the Copy menu, press the button next to Copy.
� Press the button next to Copy Number to increase or decrease the number of copies. Press the button

next to OK to confirm.
� Press the button next to Copy Black or Copy Color to copy onto A4 or 8.5” x 11” plain paper.

More copy features
▲ While in the Copy menu, press the selection button next to Settings to access the Copy Settings menu.

� Paper Size/Type: You will see menus to select paper size and paper type. A plain paper setting will print
in plain paper normal print quality. A photo paper setting will print in photo paper best quality.

� Resize: Actual size makes a copy that is the same as the size of the original, but the margins of the
copied image may be clipped. Resize to fit makes a copy that is centered with a white border around
the edges. The resized image is either enlarged or reduced to fit the size of the selected output paper.
Custom Size allows you to increase the size of the image by selecting values greater than 100% or
reduce the image size by selecting values less than 100%.

� Lighter / Darker: Adjusts the copy settings to make copies lighter or darker.

NOTE: After two minutes of inactivity the copy options will automatically return to the default settings of plain
paper A4 or 8.5” x 11” (depending on region).

Scan to a computer
You can initiate a scan from the control panel of the printer or from your computer. Scan from the control panel if
you want to quickly scan one page to an image file. Scan from your computer if you want to scan multiple pages
into one file, define the file format of the scan, or make adjustments to the scanned image.

Prepare the scan
▲ To prepare the scan:

a. Load original.
� Lift lid on product.

� Load original print side down on right front corner of glass.
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� Close lid.

b. Start scan.

Scan from the printer control panel
1. Select Scan from the printer display menu. If you do not see Scan on the printer display press the Back button

until you do.
2. Select the computer that you want to scan to from the printer display.

If you do not see your computer listed on the printer display make sure that your computer is connected to the
printer either wirelessly or through a USB cable. If you have a wireless connection and you have confirmed that
the connection is working, you will need to enable wireless scanning in the software.
a. Click the HP All-in-One desktop icon to open the Printer Software.

NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
3070 B611 series > HP Deskjet 3070 B611 series

b. Click the Scanner Actions icon.
c. Click Manage Scan to Computer.

NOTE: You can choose to keep the Scan to Computer option always active. If this feature is always active,
you will be able to select the Scan option from the printer display to scan to your wirelessly connected
computers that are in use. If this feature is not always active, then you will need to first activate the Scan to
Computer option in the Printer Software before you scan. This only affects the Scan button on the printer
control panel. Whether Scan to Computer is active or not, you will always be able to make a scan from your
computer

3. Locate the scanned image on your computer. After the scan is saved, a Windows Explorer window will open in
the directory where the scan was saved.

Scan from your computer
1. Open the HP Scan application. Click Start > Programs >HP > HP Deskjet 3070 B611 series >HP Scan
2. Select the type of scan that you want from the shortcut menu and then click Scan.

NOTE: If Show Scan Preview is selected, you will be able to make adjustments to the scanned image in
the preview screen.
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3. Select Save if you want to keep the application open for another scan, or select Done to exit the application.
4. After the scan is saved, a Windows Explorer window will open in the directory where the scan was saved.

NOTE: There is a limited number of computers that can have the scan function activated at the same time.
Press the Scan button on the printer and you will see the computers that are currently available for scanning.

Tips for copy success
• Load your original print side down on the right front corner of the glass.

• Remove the printer lid to copy or scan a book.

• To increase or decrease the contrast of your printed output, select Copy from the printer display and then select
Settings. From the Copy Settings menu select Lighter/Darker to adjust the contrast.

• To select the paper size and paper type of the printed output, select Copy from the printer diplay, then select
Settings. From the Copy Settings menu select Size to Fit to choose plain or photo paper and photo paper
size.

• To resize the image, select Copy from the printer diplay, then select Settings. From the Copy Settings menu
select Resize.

 Click here to go online for more information.

Tips for scan success
• Load your original print side down on the right front corner of the glass.
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• Clean the scanner glass and make sure that there are no foreign materials adhering to it.
• If you have a wireless connection and you have confirmed that the connection is working, you will need to enable

wireless scanning in the software to scan from the printer display. Open the Printer Software to select Scanner
Actions and then select Manage Scan to Computer.

• After you select Scan from the printer display, choose the computer that you want to scan to from the list of
printers on the printer display.

• If you have a wireless connection from your printer to your computer, and you want to always be able to quickly
scan to your connected computer, choose to have Scan to Computer always active.

• If you want to scan a document with several pages into one file instead of multiple files, start the scan with the
Printer Software instead of selecting Scan from the control panel.

• Remove the printer lid to copy or scan a book.

 Click here to go online for more information.
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7 Work with cartridges
• Check the estimated ink levels
• Order ink supplies
• Replace the cartridges
• Cartridge warranty information

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink
supply level shows an estimate of the amount of ink remaining in the cartridges.

To check the ink levels from the control panel
1. From the Control Panel home screen, which displays Copy, Scan, and Quick Forms, press the Setup button.

NOTE: If you do not see the home screen, press the Back button until you can see it.

2. Select Ink Status

To check the ink levels from the Printer Software
1. Click the HP All-in-One desktop icon to open the Printer Software.

NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 3070
B611 series > HP Deskjet 3070 B611 series

2. In the Printer Software, click Estimated Ink Levels.

NOTE: 1 If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another
printer, the ink level indicator might be inaccurate or unavailable.

NOTE: 2 Ink level warnings and indicators provide estimates for planning purposes only. When you receive a
low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays.
You do not have to replace the cartridges until the print quality is unacceptable.

NOTE: 3 Ink from the cartridges is used in the printing process in a number of different ways, including in the
initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Order ink supplies
Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer
▲ The cartridge number is located inside the cartridge door.
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Locate the cartridge number in the Printer Software
1. Click the HP All-in-One desktop icon to open the Printer Software.

NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 3070
B611 series > HP Deskjet 3070 B611 series

2. In the Printer Software, click Shop For Supplies Online. The correct cartridge number will be automatically
displayed when you use this link.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If prompted, choose your
country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/
region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

Related topics
• Choose the right cartridges on page 30

Choose the right cartridges
HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP printers
to help you easily produce great results, time after time.

Related topics
• Order ink supplies on page 29

Replace the cartridges
To replace the cartridges
1. Check that power is on.
2. Remove cartridge.

a. Open cartridge access door.

Wait for print carriage to move to right side of product.
b. Press tab on cartridge, then remove it from slot.
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3. Insert new cartridge.
a. Remove cartridge from packaging.

b. Twist orange cap to snap it off. A forceful twist may be required to remove cap.

c. Match color icons, then slide cartridge into slot until it clicks into place.
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d. Close cartridge door.

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty
does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty
date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.
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8 Connectivity
• WiFi Protected Setup (WPS – requires WPS router)
• Traditional wireless connection (requires router)
• USB Connection (non-network connection)
• Change from a USB connection to a wireless network
• Connect a new printer
• Change network settings
• Tips for setting up and using a networked printer
• Advanced printer management tools (for networked printers)

WiFi Protected Setup (WPS – requires WPS router)
These instructions are for customers who have already setup and installed the printer software. For first time
installation refer to the setup instructions that came with the printer.

To connect the HP All-in-One to a wireless network using WiFi Protected Setup (WPS), you will need the following:

� A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

NOTE: 802.11n will only support 2.4Ghz

� A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The
computer must be connected to the wireless network that you intend to install the HP All-in-One on.

NOTE: If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, follow the Push Button
method. If you are not certain your router has a push button, follow the Wireless Settings Menu method.

Push Button (PBC) method
1. Press the WiFi Protected Setup (WPS) button on your router.
2. Press and hold the Wireless button on the printer until the wireless light starts blinking. Press and hold for 3

seconds to start WPS push button mode .

NOTE: The product begins a timer for approximately two minutes in which the corresponding button on the
networking device needs to be pressed.

Wireless Settings Menu method
1. Press the Wireless button on the printer to display the Wireless menu. If the printer is printing, in an error state,

or performing a critical task, wait until the task has been completed or the error cleared before pressing the
Wireless button.

2. Select Wireless Settings from the printer display.
3. Select WiFi Protected Setup from the printer display.
4. If you have a Wi-Fi Protected Setup (WPS) router with a WPS push button, select Push Button, and then follow

the onscreen instructions. If your router does not have a push button or you are not certain if your router has a
push button, select PIN, and then follow the onscreen instructions.

NOTE: The product begins a timer for approximately two minutes during which the corresponding button on
the networking device needs to be pressed or the router PIN needs to be entered on the router’s configuration
page.

Traditional wireless connection (requires router)
To connect the HP All-in-One to an integrated wireless WLAN 802.11 network, you will need the following:
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� A wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: 802.11n will only support 2.4Ghz

� A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The
computer must be connected to the wireless network that you intend to install the HP All-in-One on.

� Network name (SSID).
� WEP key or WPA Passphrase (if needed).

To connect the product
1. Insert the product Software CD in the computer CD-ROM drive.
2. Follow the instructions on the screen.

When you are prompted, connect the product to the computer using the USB setup cable included in the box.
Follow the onscreen prompts to enter your wireless network settings. The product will attempt to connect to the
network. If the connection fails, follow the prompts to correct the problem, and then try again.

3. When the setup is finished, you will be prompted to disconnect the USB cable and test the wireless network
connection. Once the product connects successfully to the network, install the software on each computer that
will use the product over the network.

USB Connection (non-network connection)
The HP All-in-One supports a rear USB 2.0 High Speed port for connection to a computer.

NOTE: Web services will not be available with a USB direct connection.

To connect the product with the USB cable
▲ Refer to the setup instructions that came with your product for information on connecting to a computer with a

USB cable.

NOTE: Do not connect the USB cable to the product until you are prompted to do so.

If the printer software has been installed, the printer will operate as a plug and play device. If the software has not
been installed, insert the CD that came with the device and follow the onscreen instructions.

Change from a USB connection to a wireless network
If you first setup your printer and installed the software with a USB cable, directly connecting the printer to your
computer, you can easily change to a wireless network connection. You will need a wireless 802.11b/g/n network
that includes a wireless router or access point.

NOTE: 802.11n will only support 2.4Ghz

Change from a USB connection to a wireless network
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3070 B611 All-in-One series
3. Select Printer Setup and Software Selection.
4. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.

Connect a new printer
Connect a new printer
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3070 B611 All-in-One series
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3. Select Printer Setup and Software Selection.
4. Select Connect a new printer. Follow the onscreen instructions.

Change network settings
Change network settings
1. From the computer’s start menu select All Programs or Programs, and then select HP.
2. Select HP Deskjet 3070 B611 All-in-One series
3. Select Printer Setup and Software Selection.
4. Select Connect a new printer. Follow the onscreen instructions.

Tips for setting up and using a networked printer
Use the following tips to set up and use a networked printer:

• When setting up the wireless networked printer, make sure your wireless router or access point is powered on.
The printer searches for wireless routers, then lists the detected network names on the computer.

• If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from the VPN before
you can access any other device on your network, including the printer.

• Learn how to find your network security settings. Click here to go online for more information.
• Learn about the Network Diagnostic Utility and other troubleshooting tips. Click here to go online for more

information.
• Learn how to change from a USB to wireless connection. Click here to go online for more information.
• Learn how to work with your firewall and anti-virus programs during printer setup. Click here to go online for

more information.

Advanced printer management tools (for networked
printers)

When the printer is connected to a network, you can use the embedded Web server to view status information,
change settings, and manage the printer from your computer.

NOTE: To view or change some settings, you might need a password.

You can open and use the embedded Web server without being connected to the Internet. However, some
features are not available.

• To open the embedded Web server
• About cookies

To open the embedded Web server
NOTE: The printer must be on a network and must have an IP address. The IP address for the printer can be
found by pressing the Wireless button or by printing a network configuration page.

In a supported Web browser on your computer, type the IP address or hostname that has been assigned to the
printer.

For example, if the IP address is 192.168.0.12, type the following address into a Web browser such as Internet
Explorer: http://192.168.0.12.

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are browsing.
These files let the EWS recognize your computer the next time you visit. For example, if you have configured the
EWS language, a cookie helps remember which language you have selected so that the next time you access the
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EWS, the pages are displayed in that language. Though some cookies are cleared at the end of each session (such
as the cookie that stores the selected language), others (such as the cookie that stores customer-specific
preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to remove
unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of the following features:

• Starting where you left the application (especially useful when using setup wizards)
• Remembering the EWS browser language setting
• Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see the
documentation available with your Web browser.
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9 Solve a problem
This section contains the following topics:

• Improve print quality
• Clear a paper jam
• Unable to print
• Networking
• HP support

Improve print quality
1. Make sure you are using genuine HP cartridges.
2. Check the print properties to make sure you have selected the appropriate paper type and print quality from the

Media drop-down list. In the Printer Software, click Printer Actions and then click Set Preferences to access
the print properties.

3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see Check
the estimated ink levels on page 29. If the print cartridges are low on ink consider replacing them.

4. Align the printer cartridges

To align the cartridges from the Printer Software

NOTE: Aligning the cartridges ensures high-quality output. The HP All-in-One prompts you to align the
cartridges every time you install a new cartridge. If you remove and reinstall the same print cartridge, the
HP All-in-One will not prompt you to align the print cartridges. The HP All-in-One remembers the alignment
values for that print cartridge, so you do not need to realign the print cartridges.

a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenence Tasks to access the Printer

Toolbox.
c. The Printer Toolbox appears.
d. Click Align Ink Cartridges on the Device Services tab. The product prints an alignment sheet.
e. Load the cartridge alignment sheet print side down on the right front corner of the glass.
f. Follow the instructions on the on the printer display to align the cartridges. Recycle or discard the cartridge

alignment sheet.
5. Print a diagnostics page if the cartridges are not low on ink.

To print a diagnostics page
a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenence Tasks to access the Printer

Toolbox.
c. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page. Review the blue,

magenta, yellow, and black boxes on the diagnostics page. If you are seeing streaks in the color and black
boxes, or no ink in portions of the boxes, then automatically clean the cartridges.
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6. Clean the print cartridges automatically, if the diagnostic page shows steaks or missing portions of the color and
black boxes.

To clean the cartridges automatically
a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenence Tasks to access the Printer

Toolbox.
c. Click Clean Ink Cartridges on the Device Services tab. Follow the onscreen instructions.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear a paper jam
If you see paper jammed and can access from the exterior of the printer, pull out jammed paper and then press OK.
If you cannot see or access paper from the exterior, open cartridge access door to locate jam.

Open cartridge access door to locate the jam.
1. If the paper jam is located in the cartridge access area, pull on the paper to remove jammed paper.

NOTE: When you remove the paper make sure that you do not touch white encoder strip attached to the
carriage.

2. If the paper jam is located towards the back of the printer, open the cleanout door to access.
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a. Open cleanout door.
b. Remove jammed paper.
c. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

3. If the paper cannot be reached by opening the cartridge access door, close the cartridge access door.
a. Remove all paper or media from the paper tray.
b. Rotate printer until it rests on its left side.
c. Slide out the paper tray, then remove jammed paper from inside the printer.

d. Slide paper tray back into place.
e. Rotate printer so it stands on its base, then load paper.

Press the OK selection button on the control panel to continue the current job.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Prevent paper jams
• Do not overfill the input tray.
• Remove printed papers from the output tray frequently.
• Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
• Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray

must be the same size and type.
• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide

does not bend the paper in the input tray.
• Do not force paper too far forward in the input tray.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Unable to print
If you're having trouble printing, you can download the HP Printing Diagnostic Utility, which can troubleshoot this
issue for you automatically. To get the utility, click the appropriate link:

NOTE: The HP Printing Diagnostic Utility may not be available in all languages.

Take me to the HP Printing Diagnostic Utility download page (32-bit Windows).

Take me to the HP Printing Diagnostic Utility download page (64-bit Windows).

Resolve print issues

NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print,
try the following in order:

1. Check for error messages and resolve.
2. Disconnect and reconnect the USB cable.
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3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline
a. Depending upon your operating system, do one of the following:

• Windows 7: From the Windows Start menu, click Devices and Printers.
• Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
• Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and

Faxes.
b. Either double-click the icon for your product or right-click the icon for your product and select See what’s

printing to open the print queue.
c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer

Offline.
d. If you made any changes, try to print again.

4. Verify that the product is set as the default printer.

To verify that the product is set as the default printer
a. Depending upon your operating system, do one of the following:

• Windows 7: From the Windows Start menu, click Devices and Printers.
• Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
• Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and

Faxes.
b. Make sure the correct product is set as the default printer.

The default printer has a check mark in a black or green circle next to it.
c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default

Printer.
d. Try using your product again.

5. Restart the print spooler.

To restart the print spooler
a. Depending upon your operating system, do one of the following:

Windows 7
• From the Windows Start menu, click Control Panel, System and Security, and then Administrative

Tools.
• Double-click Services.
• Right-click the Print Spooler, and then click Properties.
• On the General tab, next to Startup type, make sure that Automatic is selected.
• If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista
• From the Windows Start menu, click Control Panel, System and Maintenance, Administrative

Tools.
• Double-click Services.
• Right-click the Print Spooler service, and then click Properties.
• On the General tab, next to Startup type, make sure that Automatic is selected.
• If the service is not already running, under Service status, click Start, and then click OK.

Windows XP
• From the Windows Start menu, right click My Computer.
• Click Manage, and then click Services and Applications.

Chapter 9

40 Solve a problem

Solve a problem



• Double-click Services, and then select Print Spooler.
• Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default
Printer.

d. Try using your product again.
6. Restart the computer.
7. Clear the print queue.

To clear the print queue
a. Depending upon your operating system, do one of the following:

• Windows 7: From the Windows Start menu, click Devices and Printers.
• Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
• Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and

Faxes.
b. Double-click the icon for your product to open the print queue.
c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.
d. If there are still documents in the queue, restart the computer and try printing again after the computer has

restarted.
e. Check the print queue again to make sure it is clear, and then try to print again.

If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed to the next solution.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear the print carriage
Remove any objects, such as paper, that are blocking the print carriage.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when removing
jammed paper from inside the product.

 Click here to go online for more information.

Prepare paper tray
Open paper tray
▲ Paper tray must be open to begin printing.

 Click here to go online for more information.

Prepare printer
If you are not satisfied with the print quality, clean the cartridges automatically from the control panel.
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Clean the cartridges automatically.
1. From the home screen, which displays Copy, Scan, and Quick Forms, press the Setup button.

NOTE: If you do not see the home screen, press the Back button until you can see it.

2. Select Clean Printhead from the Tools menu.
3. Follow the onscreen instructions.

To maintain the cartridges, use the printer's Auto Power-Off feature to manage the printer's power use.

For more information, see Auto Power-Off on page 8

Printer failure
Resolve printer failure.
▲ If you have already turned the printer off and then on, and this does not solve your problem, contact HP support.

  Please contact HP support for help .

Printhead failure
The printhead in this product has failed.

 Please contact HP support for help .

Ink cartridge problem
First try removing and reinserting the cartridges. If this does not work, clean the cartridge contacts. If your problem
is still not resolved, Replace the cartridges on page 30.

Clean the ink cartridge contacts

CAUTION: The cleaning procedure should take only a few minutes. Make sure that the ink cartridges are
reinstalled in the product as soon as possible. It is not recommended to leave the ink cartridges outside of the
product longer than 30 minutes. This could result in damage to both the printhead and the ink cartridges.

1. Check that power is on.
2. Open cartridge access door.

Wait for print carriage to move to right side of product.
3. Press tab on cartridge indicated in the error message, then remove it from slot.
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4. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts on the ink
cartridge. The electrical contacts are four small rectangles of copper or gold-colored metal on the bottom of the
ink cartridge.

5. Wipe only the contacts with a dry swab or lint-free cloth.

CAUTION: Be careful to touch only the contacts, and do not smear any of the ink or other debris elsewhere
on the cartridge.

6. On the inside of the product, locate the contacts in the printhead. The contacts look like a set of four copper or
gold-colored pins positioned to meet the contacts on the ink cartridge.

7. Use a dry swab or lint-free cloth to wipe the contacts.
8. Reinstall the ink cartridge.
9. Close the access door, and check if the error message has gone away.
10. If you still receive the error message, turn the product off, and then on again.

 Click here to go online for more information.

Setup Cartridges
When you first setup the printer, you must install the cartridges that shipped in the box with the printer. These
cartridges are labeled SETUP, and they calibrate your printer before the first print job. Failure to install the SETUP
cartridges during the initial product setup causes an error. If you installed a set of regular cartridges, remove them
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and install the SETUP cartridges to complete printer setup. After printer setup is complete, the printer can use regular
cartridges.

WARNING! You must replace the orange caps on the regular cartridges you remove, or they will quickly dry
out. Some ink will still evaporate, but less than if the cartridges are uncapped. You can use the orange caps
from the SETUP cartridges if necessary.

 Please contact HP support for help .

Cartridge Supply Upgrade
Try to get the printer to recognize the supply upgrade cartridge.
1. Remove the supply upgrade cartridge.
2. Insert the original cartridge in the carriage.
3. Close the access door, then wait until the carriage stops moving.
4. Remove the original cartridge, then replace with the supply upgrade cartridge.
5. Close the access door, then wait until the carriage stops moving.

If you still receive a supply upgrade problem error message contact HP support.

 Please contact HP support for help .

Older Generation Cartridge
You will need to use a newer version of this cartridge. To identify a newer version of the cartridge, look at exterior
of the cartridge package and find the Warranty Ends date.

If it says ‘v1’ several spaces to the right of the date, then the cartridge is the updated newer version.

 Please contact HP support for help .
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Networking
• Learn how to find your network security settings. Click here to go online for more information.
• Learn about the Network Diagnostic Utility and other troubleshooting tips. Click here to go online for more

information.
• Learn how to change from a USB to wireless connection. Click here to go online for more information.
• Learn how to work with your firewall and anti-virus programs during printer setup. Click here to go online for

more information.

HP support
• Register the product
• Support process
• HP support by phone
• Additional warranty options

Register the product
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product
support alerts. If you did not register your printer while installing the software, you can register now at http://
www.register.hp.com.

Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers.

It is the fastest source for up-to-date product information and expert assistance and includes the following
features:
• Fast access to qualified online support specialists
• Software and driver updates for the product
• Valuable product and troubleshooting information for common problems
• Proactive product updates, support alerts, and HP newsgrams that are available when you register the

product
3. Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone
Phone support options and availability vary by product, country/region, and language.

This section contains the following topics:

• Phone support period
• Placing a call
• Support phone numbers
• After the phone support period

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To
determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support.
Standard phone company charges apply.
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Placing a call
Call HP support while you are in front of the computer and the product. Be prepared to provide the following
information:

• Product name (HP Deskjet 3070 B611 All-in-One series)
• Model number (located inside the cartridge door)

• Serial number (located on the back or bottom of the product)
• Messages that appear when the situation occurs
• Answers to these questions:

◦ Has this situation happened before?
◦ Can you re-create it?
◦ Did you add any new hardware or software to your computer at about the time that this situation began?
◦ Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be available at the
HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for
your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP All-in-One at additional costs. Go to www.hp.com/support, select
your country/region and language, then explore the services and warranty area for information about the extended
service plans.
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10 Technical information
The technical specifications and international regulatory information for the HP All-in-One are provided in this
section.

For additional specifications, see the printed documentation that came with the HP All-in-One.

This section contains the following topics:

• Notice
• Cartridge chip information
• Specifications
• Environmental product stewardship program
• Regulatory notices

Notice

Cartridge chip information
The HP cartridges used with this product contain a memory chip that assists in the operation of the product. In
addition, this memory chip collects a limited set of information about the usage of the product, which might include
the following: the date when the cartridge was first installed, the date when the cartridge was last used, the number
of pages printed using the cartridge, the page coverage, the printing modes used, any printing errors that might
have occurred, and the product model. This information helps HP design future products to meet our customers
printing needs.

The data collected from the cartridge memory chip does not contain information that can be used to identify a
customer or user of the cartridge or their product.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling program (HP
Planet Partners: www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this cartridge might
have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the memory chip. If
you prefer to not allow access to this information, you can render the chip inoperable. However, after you render
the memory chip inoperable, the cartridge cannot be used in an HP product.

If you are concerned about providing this anonymous information, you can make this information inaccessible by
turning off the memory chip's ability to collect the product's usage information.
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To disable the usage information function
1. From the printer display home screen press the Setup button.

NOTE: The home screen displays Copy, Scan, and Quick Forms. If you do not see these options press
the Back button until you do.

2. From the Setup menu, select Tools.
3. From the Tools menu, select Cartridge Chip Info. You can choose to disable or enable the usage information

function

NOTE: You can continue to use the cartridge in the HP product if you turn off the memory chip's ability to collect
the product's usage information.

Specifications
Technical specifications for the HP All-in-One are provided in this section. For complete product specifications, see
the Product Data Sheet at www.hp.com/support.

System requirements

For information about future operating system releases and support, visit the HP online support Web site at
www.hp.com/support.

Environmental specifications
• Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)
• Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
• Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
• Non-operating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)
• In the presence of high electromagnetic fields, it is possible the output from the HP All-in-One may be slightly

distorted
• HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due

to potential high electromagnetic fields

Paper tray input capacity

Plain paper sheets (80 g/m2 [20lb]): Up to 50

Envelopes: Up to 5

Index cards: Up to 20

Photo paper sheets: Up to 20

Paper tray output capacity

Plain paper sheets (80 g/m2 [20lb]): Up to 20

Envelopes: Up to 5

Index cards: Up to 10

Photo paper sheets: Up to 10

Paper size

For a complete list of supported media sizes, see the printer software.

Paper weights

Plain Paper: 64 to 90 g/m² (16 to 24 lb)

Envelopes: 75 to 90 g/m² (20 to 24 lb)

Cards: Up to 200 g/m² (110-lb index maximum)

Photo Paper: Up to 280 g/m² (75 lb)
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Print specifications
• Print speeds vary according to the complexity of the document
• Method: drop-on-demand thermal inkjet
• Language: PCL3 GUI

Copy specifications
• Digital image processing
• Copy speeds vary according to the complexity of the document and model
• Resolution: up to 600 dpi

Scan specifications
• Optical Resolution: up to 1200 dpi
• Hardware Resolution: up to 1200 x 2400 dpi
• Enhanced Resolution: up to 2400 x 2400 dpi
• Bitdepth: 24-bit color, 8-bit grayscale (256 levels of gray)
• Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
• Supported File Types: BMP, JPEG, PNG, TIFF, PDF
• Twain Version: 1.9

Print resolution

Draft mode
• Color Input/Black Render: 300x300dpi
• Output (Black/Color): Automatic

Normal mode
• Color Input/Black Render: 600x300dpi
• Output (Black/Color): Automatic

Plain-Best mode
• Color Input/Black Render: 600x600dpi
• Output: 600x1200dpi (Black), Automatic (Color)

Photo-Best mode
• Color Input/Black Render: 600x600dpi
• Output (Black/Color): Automatic

Max DPI mode
• Color Input/Black Render: 1200x1200dpi
• Output: Automatic (Black), 4800x1200 optimized dpi (Color)

Power specifications

CQ191-60017
• Input voltage: 100-240Vac (+/- 10%)
• Input frequency: 50/60 Hz (+/- 3Hz)

CQ191-60018
• Input voltage: 200-240Vac (+/- 10%)
• Input frequency: 50/60 Hz (+/- 3Hz)

NOTE: Use only with the power cord supplied by HP.

Cartridge yield

Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information

If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for
recycling has been incorporated into this product. The number of materials has been kept to a minimum while
ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners
and other connections are easy to locate, access, and remove using common tools. High priority parts have been
designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at:

www.hp.com/hpinfo/globalcitizenship/environment/index.html

This section contains the following topics:

• Eco-Tips
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Power consumption
• Sleep mode
• Disposal of waste equipment by users in private households in the European Union
• Chemical Substances

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to
help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in
this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Your product's Eco features
• Energy Savings information: To determine the ENERGY STAR® qualification status for this product, see

www.hp.com/go/energystar.
• Recycled Materials: For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Paper use

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify
plastics for recycling purposes at the end of product life.

Material safety data sheets

Material safety data sheets (MSDS) can be obtained from the HP Web site at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners
with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling
some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many
countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information,
go to the following Web site:

Chapter 10

50 Technical information

Technical inform
ation

http://www.hp.com/hpinfo/globalcitizenship/environment/index.html
http://www.hp.com/hpinfo/globalcitizenship/environment/
http://www.hp.com/go/energystar
http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/
http://www.hp.com/go/msds
http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/


www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Sleep mode
• Power usage is reduced while in Sleep mode.
• After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.
• The time to Sleep mode cannot be changed.
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Disposal of waste equipment by users in private households in the European Union
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Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our products as
needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Regulatory notices
The HP All-in-One meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

• Regulatory model identification number
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• European Union Regulatory Notice
• Regulatory wireless statements

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model
Number for your product is VCVRA-1111. This regulatory number should not be confused with the marketing name
(HP Deskjet 3070 B611 All-in-One series, etc.) or product numbers (CB730A, etc.).

FCC statement
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:

• Low Voltage Directive 2006/95/EC
• EMC Directive 2004/108/EC
• Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements of the following
EU Directive:

• R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards (European
Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or product family and
available (in English only) either within the product documentation or at the following web site: www.hp.com/go/
certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications products and for EU
harmonized telecommunications products, such
as Bluetooth® within power class below 10mW.
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For EU non-harmonized telecommunications
products (If applicable, a 4-digit notified body
number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA countries: Austria,
Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary,
Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal,
Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue telephone networks.
Products with wireless LAN devices
• Some countries may have specific obligations or special requirements about the operation of Wireless LAN

networks such as indoor use only or restrictions of the channels available. Please make sure that the country
settings of the wireless network are correct.

France
• For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may be used indoors

for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For outdoor use, only the 2400-MHz
to 2454-MHz frequency band (channels 1 to 7) may be used. For the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:

• Exposure to radio frequency radiation
• Notice to users in Brazil
• Notice to users in Canada
• Notice to users in Taiwan

Exposure to radio frequency radiation

Notice to users in Brazil

(continued)
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Notice to users in Canada

Notice to users in Taiwan
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